Description

Drained Nonlinear
Analysis of a
Retaining Wall

For LUSAS version: 17.0

For software product(s): | Any Plus version.

With product option(s): | Nonlinear

Note: The example exceeds the limits of the LUSAS Teaching and Training Version.

Description

The behaviour of a single

Original ground level
propped retaining wall is to Zomﬂ
be investigated in the long

term. Drained  soil '

parameters are used 'Eéi?,vgg ?nn
throughout. .

Horizontal displacement is
restrained at the left and
right hand edge and both
horizontal and  vertical
displacement is restrained at
the base of the soil as the
soil rests on solid rock.

101m

The wall is ‘wished-in-place’
meaning that construction of
the wall is not modelled.

Units of kN, m, t, s, C are
used throughout.

j

‘4 101m
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Modelling

Drained Nonlinear Analysis of a Retaining Wall

Objectives

The required output from the analysis consists of:

U Displacement of the wall toe towards the excavation
O Surface heave immediately behind the wall

O Contours of plastic strain around the excavation

O Prop force per m length of wall

O Bending moment in the wall at 10m depth

Keywords

2D, Inplane, Retaining wall, Drained, Nonlinear, Excavation, Surface heave, Plane
strain, Prop force, Bending Moment, Profile variation, Initial Soil stress, K,
Initialisation.

Associated Files

U drained_wall_modelling.vbs carries out the modelling of the example.

Running LUSAS Modeller

For details of how to run LUSAS Modeller see the heading Running LUSAS Modeller
in the Examples Manual Introduction.

Note. This example is written assuming a new LUSAS Modeller session has been
started. If continuing from an existing Modeller session select the menu command File
> New to start a new model file.

Creating a new model

e Enter a File name of drained_wall

o Use the default User-defined working folder.
e Ensure an Analysis type of Structural is set.
e Select an Analysis Category of 2D Inplane
e Set Model units of kN,m,t,s,C

e Leave the Timescale units as Seconds

e Select a Startup template of None




| Attributes

|Mesh
| Surface...

| Utilities

| Variation...

Modelling

Ensure the Layout grid is set as None
Enter a Title of Drained analysis of a propped retaining wall

Click the OK button.

Note. Save the model regularly as the example progresses. Use the undo command
to undo mistakes as far back as the last save.

Note. For a 2D Inplane analysis category the vertical axis is set to be the Y-axis.

Mesh Definition

The surfaces are to be meshed using plane-strain quadrilaterals with a quadratic
interpolation order (QPNS).

Select the Plane Strain, Quadrilateral, Quadratic elements. Ensure the Regular
mesh option is selected with Automatic divisions so that Modeller uses the mesh
divisions assigned to each line.

Give the attribute the name Plane Strain quads and click the OK button to add the
mesh attribute to the &% Treeview.

In the &b Treeview click on the mesh attribute Plane Strain guads with the right-
hand mouse button and select the Set Default option. This will ensure all newly
created surfaces will be assigned the elements defined in this mesh attribute.

Profile Variation

The Young’s Modulus of the soil varies with depth and is described by a Profile
Variation. It varies linearly from a value of 0.0kN/m? at the surface to 6.06ESkN/m? at
a depth of 101m.

Select Profile Variation and press Next.

Select New... and enter the values of Distance (x) 0.0 Value (y) 0.0, Distance (x)
101.0 Value (y) 6.06E5 in the Line Profile Variation dialogue box which appears.
Enter E_LineP for the line profile name and click OK.

Select the line profile named E_LineP by left clicking on it and then click on the
‘Add to’ button >> to transfer it to the profile set. The origin of the profile line is by
default x origin 0.0, y origin 0.0 and so does not need to be changed. Similarly, the
positive direction of the line profile is, by default, the negative vertical and again
does not need modification.

Enter the name E_mod for profile variation and click Finish.




| Geometry
Line
By Coords...

\%

| Geometry
Surface >
By Sweeping...

| Geometry
| Surface >

By Sweeping...

Drained Nonlinear Analysis of a Retaining Wall

Feature Geometry

e Turn off the display of the Mesh layer in = Treeview.

il Enter coordinates of (0, 0), (20, 0), (21, 0), (25, 0) and (101, 0) to define four lines
representing the original ground level (all Z coordinates should be zero or left blank).

Use the Tab key to move to the next entry field on the dialog. When all coordinates
have been entered click the OK button.

e Press CTRL-A to select all the Lines just drawn.

él Ensure the Translate option is selected and enter a value of —-1.5in Y.

e Click OK to sweep the Lines to create the Surfaces.

Drag a box around these 4 Lines

e Select the bottom four horizontal Lines by dragging a box around them.

él Ensure the Translate option is selected and enter a value of —-1.5in Y.
e Click OK to sweep the Lines to create the Surfaces.

Repeat the preceding commands eight times, selecting the bottom four lines of the
model each time and sweep the lines by -2.0, -2.13, -2.13, -2.0, -2.0, -2.0, -2.49 and
-2.25 metres in Y as shown above.

Point B/\

EJ
Point A @J

e Select Point A shown.




Modelling

|GeFf’(;nin‘:"y S I Ensure the Transiate option is selected and enter a value of -81in Y.
Move... . .
¢ Click OK to move the Point.
e Select Point B shown.
| Geometry ﬂ . .
Point S Ensure the Translate option is selected and enter a value of -33.25in Y.
Move... . .
e Click OK to move the Point.
e Select the two Lines shown. If §
necessary zoom in to make the b
selection easier.
|Geso$fz?e' S 8] Ensure the Transiate option is
By Sweeping... selected and enter a value of -81in Y.
Click OK to sweep the Lines to create
the Surfaces.
Select these 2 lines
e Select the Point shown. b
|Ge§;:§"y — 2] Ensure the Translate option is
Move... selected and enter a value of 38 in X.

e Click OK to move the Point.

Select this point




| Geometry
Line >
By Poaints...
| Geometry
Surface >
By Lines...
| Attributes
Mesh >
Line...

Drained Nonlinear Analysis of a Retaining Wall

e Select the two Points shown. i

il Create a Line between the
two selected Points.

Select these points

e Select the Line just drawn i
along with the three Lines as
shown.

EI Create a Surface from the
four selected Lines.

9

@ Select'these 4 lines

Mesh Grading

e Define a Line mesh with element type None and 1 division.

e Enter the attribute name as Null 1 and click the Apply button to add the attribute to
the &% Treeview and keep the dialog active.




Modelling

e Define a Line mesh with 5 divisions.

e Select the Spacing button.

e Select the Uniform transition option and set the Ratio of first to last element to 4
e Click OK to accept the spacing properties.

e Give the attribute name as Null 5 Graded and click Apply to add the attribute to
the &% Treeview and keep the dialog active.

e Define a Line mesh with 10 divisions.
e Select the Spacing button.

e Select the Uniform transition option and set the Ratio of first to last element to
0.2

e Click OK to accept the spacing properties.
e Give the attribute name as Null 10 Graded and click OK to add the attribute to the
c&; Treeview.

Assigning the mesh attributes

|
|
OTOT0On
|
|

[ |

e ————————tHtHHA

Linesto assign Nuft.1 dataset

T

e Box-select the lines as shown and assign the mesh attribute Null 1.




Drained Nonlinear Analysis of a Retaining Wall

Note. The selection of some of the sets of lines as shown in the next two images is

best done by changing the selection cursor and

additionally using a special keyboard

shortcut which causes any lines passing through a box-selection to be selected.

To prepare for this:

M Change the cursor to the Select Lines cursor.

e Hold down the ALT key and 1
box-select each set of

horizontal lines as shown in the

preceding image and assign the

mesh attribute Null 5 Graded.

Note. Pressing the Shift key at
the same time as the ALT key will
allow extra lines to be added to a

lassign Null'5 graded dataset

selection
Linesto
-
| I
e Select the remaining lines as L
shown and assign the mesh bt

attribute Null 10 Graded.

N

Note. See the Keyboard Shortcut
Guide for more details on the use of
keyboard shortcuts.

Linest

R

o———————

Foooooo7As




| Attributes

Material
Isotropic...

Modelling

e Turn on the Mesh layer in the  }
Treeview to see the mesh. Pt

Note. If the mesh is graded with the smaller elements at the wrong end of a line
reverse the line by selecting the line using the Geometry>Line>Reverse menu
selection. If errors have been made in mesh assignments simply re-select any lines with
an incorrect mesh assignment and re-assign the correct line mesh.

Material Properties

An isotropic elastic material will be used for the retaining wall while an isotropic
nonlinear material utilising the Mohr-Coulomb failure surface will be used for the soil.
The initial stress state is defined by assigning a lateral earth pressure, Kq, of 2 to both
the soil and concrete wall.

With the Elastic tab selected enter the isotropic material properties for the wall as
Young’s Modulus 28E6 kN/m? Poisson’s Ratio 0.15 and Mass Density 2.03874
tonne/m®.

e Enter the attribute name as Concrete Wall.

e Click the Ko Initialisation option and enter a Coefficient of lateral earth
pressure of 2

o Click the Apply button to add the attribute to the &b Treeview and keep the dialog
active.

e With the Elastic tab selected enter the isotropic material properties for the soil as
Young’s Modulus 1*E_mod, Poisson’s Ratio 0.2 and Mass Density 2.03874
tonne/m°.




Drained Nonlinear Analysis of a Retaining Wall

Note. The 1*E_mod indicates that the Young’s Modulus is defined by a Profile
variation scaled by a factor of 1. Enter 1 in the grid location and click on the 3 button.
Select the E_mod variation from the drop down list.

Click the Plastic option and from the Model drop-down list select the Mohr-
Coulomb (model 65) entry.

Enter an Initial cohesion value of 0

Enter an Initial friction angle value of 25

Enter an Final friction angle value of 25

Enter a Dilation angle value of 25

In the tension section enter a Cohesion hardening value of 0

In the tension section enter a Limiting plastic strain value of 1000

Click the Ko Initialisation option and enter a Coefficient of lateral earth
pressure of 2.

Enter the attribute name as Nonlinear Soil

Click the OK button to add the attribute to the c&n Treeview.

TIsotropic B
¥ Plastic [~ Creep [~ Damage [~ Shrinkage [~ Viscous [~ Twophase ¥ Ko Initialisation
"Eiastic Plastic | Ko Initissation |

IMohr-Cou\omb {model 65) j Value

Initizl cohesion 0.0

Initial friction angle 20

Final friction angle 250

Dilation angle 250
—Hardenin |
[ Cohesion i | Limiting plastic strain |
1] 0.0 1.0E3
!

Mame | Monlinzar Sail j ﬁ @

OK I Zancel I Apply | Help
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Modelling

Assigning material properties

To assign the material properties groups will be used. Groups are very useful in
allowing features of the model to be turned-on and off to aid the assignment of
attributes or the viewing of results on selected features of the model.

il Change the cursor back to the normal cursor.

e Select the ten surfaces that form the retaining wall as shown.

i

P

rCrT 1T T 1l

4

Surfaces to assign GoncretetyWall matetial

NOTE: Mesh not shown for clarity

Geomet - . .
| ‘i;’{gjp*y ~ Create a group containing the wall elements only and rename it Wall. Click OK.
[ New Group... . . . .
e With the ten surfaces of the wall still selected drag and drop the material attribute
Concrete Wall from the &b Treeview onto the selection. With the Assign to
surfaces option selected click OK to assign the material attribute.
o Inthe L=l Treeview right-click on the Wall group and select Invisible.
e Select the whole visible model by pressing the Ctrl-A keys.
G - . I,
| %’:;Stry S Create a group containing the soil elements only and rename it Soil. Click OK.
New Group...

e Drag and drop the material attribute Nonlinear Soil from the & Treeview onto the
selection. With the Assign to surfaces option selected click OK to assign the
material attribute.

11



| Attributes

Support...

Drained Nonlinear Analysis of a Retaining Wall

o Inthe L=l Treeview right-click on the Wall group and select Visible.

Supports

Define supports to prescribe zero horizontal displacement as well as zero horizontal and
vertical displacement.

Click on the option to fix the Translation in X.

Enter the attribute name as Fixed in X and click the Apply button to add the
attribute to the &% Treeview and keep the dialog active.

Click on the option to fix the Translation in Y.

Enter the attribute name as Fixed in X and Y and click the OK button to add the
attribute to the & Treeview.

Assign the supports to the model.

Select the vertical Lines on the left-hand side and right-hand side of the model and

drag and drop the support attribute Fixed in X from the & Treeview onto the
selection. With the Assign to lines option selected click OK to assign the support

attribute to All loadcases.

Select the Point which
represents the top-left
corner of the concrete
wall as shown and
drag and drop the
support attribute Fixed

in X from the

Treeview onto the
selection.  With the
Assign  to  Points
option selected click
OK to assign the
support attribute to All
analysis  loadcases.
This support
represents the prop.

Select the 3 horizontal
Lines representing the
bottom limit of the soil
and drag and drop the
support attribute Fixed

g ok A\i EE
% 3 “hxfe\lexct this Paint h
— \ \\ —
SRRl -~

T 1 1
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| Attributes

Modelling

| Loading...

| Attributes

| Birth and Death...

in X and Y from the & Treeview onto the selection. With the Assign to lines
option selected click OK to assign the support attribute to All analysis loadcases.

Loading

The initial in situ ground conditions must be established in the first loadcase of the
analysis. This is carried out using a gravity (body force) load.

e Select the Body force tab from the Structural Loading dialog and click Next
e Enter —9.81 in Linear acceleration in Y Dir.
e Enter the attribute name as Gravity and click Finish.

Assign the loads to the model.

Gravity is assigned to the whole model.

¢ With the whole model selected drag and drop the loading attribute Gravity from the

& Treeview onto the selection. With the Assign to Surfaces option selected click
OK to assign the loading attribute to Loadcase 1

e Inthe Treeview drag and drop the Geometry layer name beneath the Attributes
layer name.

Birth and Death

The Birth and Death feature must be used to simulate the removal of soil during
excavation in front of the wall. Excavation will take place over eight loadcases.

e Select the Deactivate tab and click Next. Select Percentage to Redistribute and
ensure the value is set to 100%. Enter the attribute name as Excavation.

e Click Finish to add the attribute to the c&: Treeview.
Assign the deactivation to the model.

e Use the zoom-in button to enlarge the view of the top-left corner of the model.

. Iillf necessary, for clarity, turn -off the display of the loading by pressing the
loading on/off button.

13



Drained Nonlinear Analysis of a Retaining Wall

Select the top surface representing the first
layer of soil to be removed in front of the
retaining wall and drag and drop the
deactivation attribute Excavation from the
& Treeview onto the selection. With the
Assign to surfaces option selected enter the
Loadcase name as Excavation to -1.50m
and click OK to assign the attribute.

Select the next surface down in front of the
wall and drag and drop the deactivation

attribute Excavation from the & Treeview

=

DLV

|

onto the selection. With the Assign to surfaces option selected enter the Loadcase
name as Excavation to -3.00m and click OK to assign the attribute.

Repeat this procedure, selecting the next
surface down each time and renaming the
loadcases Excavation to -5.00m, Excavation
to -7.13m, Excavation to -9.26m,
Excavation to -11.26m, Excavation to -
13.26m and Excavation to -15.26m
respectively. The adjacent image shows the
final excavation assignment made.

Note. Deactivated surfaces (and hence
elements) can be visualised and checked by
setting each loadcase active in the @ Treeview.

Analysis Control

&

The use of a Mohr-Coulomb nonlinear material in this example dictates that a nonlinear
analysis control must be specified.

o Inthe (& Treeview right-click on Loadcase 1 and rename it to In situ

e In the @ Treeview right-click on In situ and select Nonlinear & Transient from

the Controls menu.

14



| File

Running the Analysis

| Save

In the Incrementation
section:

Select the Nonlinear
option and choose

Manual incrementation.

In the Solution strategy
section:

e Set the Max number
of iterations to 50.

e Set the Residual force
norm to 0.01.

e Set the Incremental
displacement norm to
0.01.

Nonlinear & Transient

r~ Incrementation — Solution strategy
¥ Morlinesr I=| Samieizs previous sadease
Inciementation M anual 'I Max number of iterations IEU
Starting load factor 1 Residual farce narm IEI m
Max change in load factor o Inciemental displacement nom Ig_m
Max total load Factor 1 Advanced |
I¥ | £idjist et Based om Gonveraente Histon
Iterations per increment 4 r~ Incremental LUSAS file output
Options.. | Advanced... I Sarieias previous [oedease
Output file |1
Thermal VI
= Piat file [1
Initial time: step 1]
Restart file: ID
Tatal responge time 100EE
. ber af d restart ID
= Autamatic fime stepping S MUMBEL Bl Savea(Eiars
Adianiced Log e I‘I
History file |1
Max time steps of increments o
(1] I Cancel | Help |

e Click OK to set the loadcase control.

Saving the model

El Save the model file.

Running the Analysis

El Open the Solve Now dialog. Press OK to run the analysis.

A LUSAS Datafile will be created from the model information. The LUSAS Solver
uses this datafile to perform the analysis.

If the analysis is successful...

Analysis loadcase results are added to the (B Treeview

In addition, 2 files will be created in the Associated Model Data directory where the

model file resides:

O drained_wall.out this output file contains details of model data, assigned
attributes and selected statistics of the analysis.
0 drained_wall.mys this is the LUSAS results file which
automatically into the Treeview to allow results processing to take place.

is loaded

15



| File

Drained Nonlinear Analysis of a Retaining Wall

[New...

| File

| Script

| Run Script...

If the analysis fails...

If the analysis fails, the output file will provide information relating to the nature of the
error encountered. A common mistake made when using LUSAS Modeller for the first
time is to forget to assign particular attribute data (geometry, mesh, supports, loading
etc.) to the model. Any errors listed in the output file should be fixed in LUSAS
Modeller before saving the model and re-running the analysis.

Rebuilding a Model

If errors are listed that for some reason cannot be corrected, a file is provided to re-
create the model information correctly, allowing a subsequent analysis to be run
successfully.

O drained_wall_modelling.vbs carries out the modelling of the example.

Ql Start a new model file. If an existing model is open Modeller will prompt for
unsaved data to be saved before opening the new file.

e Enter the file name as drained_wall

To recreate the model, select the file drained_wall_modelling.vbs located in the
\<LUSAS Installation Folder>\Examples\Modeller directory.

El Rerun the analysis to generate the results

Viewing the Results

Loadcase results can be seen in the () Treeview, and for a nonlinear analysis the load
case results for the last solved loading increment are set active by default.

e If present, turn off the Geometry, Mesh, Utilities and Attributes in the
Treeview.
Wall Displacement

o In the '8 Treeview right-click on the results for Excavation to —13.26m and Set
Active.

e If not already on, add the Deformed mesh to add the deformed mesh layer to the
Treeview.

16



| utilities

Graph Wizard...

Viewing the Results

e In the panel at the bottom of the Treeview press the Deformations... button,
select the Specify factor option and specify a factor of 5. Press OK to return.

e Double click the View properties control in the Treeview. On the View tab
ensure the option to Show only activated elements is selected. Click OK to
visualise the deformed mesh for the active elements at increment 8, magnified by a
factor of 5.

i

]
[
l:z
i
Fi

[N
af'"il
/

I

]
/

A graph of the deformation of the wall toe over a range of loadcases will now be
created using the graph wizard.

e Zoom into the top left-hand side of the model and select the node at the wall toe.

e With the Time history option Select this nod
selected click Next. Lﬁ_eec ot

Firstly define the data to be used for
the X axis.

e Selected the Named option and
click Next.

e Select Loadcase ID from the drop -
down list and click Next.

Secondly define the data for the Y

17



Drained Nonlinear Analysis of a Retaining Wall

axis.
e With the Nodal option selected and click Next.

e Select Displacement from the Entity drop down list and DX from the Component
drop down list.

e The selected node number will appear in the Specify node drop down list. Click
Next.

e Enter suitable text for the graph titles and click Finish to display the graph of
displacement of the wall toe towards the excavation.

Drained analysis of a propped retaining wall

01 Horizantal displacerment of wall toe

0.0s

005
R
015
02
025
03k

Displacernent

o w©
Loadcase ID
—®— Displacement ¥ Node 380{2) / Loadcase ID{1)

. El Close the graph window.
. Maximise the graphics window.

18



| utilities

Graph wizard...

Viewing the Results

Surface Heave
e Select the node at the top of the back of the wall.

e With the Time history option .
selected click Next. t»

Firstly define the data to be used for
the X axis.

e Selected the Named option and  Select this node
click Next.

e Select Loadcase ID from the drop
down list and click Next.

Secondly define the data for the Y
axis.

e With the Nodal option selected and click Next.

o Select Displacement from the Entity drop down list and DY from the Component
drop down list.

e The selected node number will appear in the Specify node drop down list. Click
Next.

e Enter suitable text for the graph titles and click Finish to display the graph of heave
behind the wall.

Drained analysis of a propped retaining wall
Surface heave behind wall

0.07
0.06
0.08
0.04
0.03
0.02

Displacernent

0.01

m o @
Loadcase 1D
—®— Displacement ¥ Mode 753(4) / Loadcase ID(3)

. E] Close the graph window then =J01X] maximise the graphics window.
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Drained Nonlinear Analysis of a Retaining Wall

Plotting contours of plastic strain in the soil

Because the model contains elements with two different material properties the active
set on which results are to be plotted must be selected.

e In the Treeview right-click on the group name Soil and select Show Results >
Results Plots> Show Results Only On This Group

e With no features selected click the right-hand mouse button in a blank part of the
graphics window and select Contours to add the contours layer to the [ Treeview.

e Select Plastic strain — Plane strain from the Entity drop down list and EPE from
the component drop down list.

e Select the Contour Range tab and set the Maximum to 0.01 (1% strain).

e Click the OK button to display contours of the plastic strain distribution around the
wall.

Analysis: Analysis 1
Loadcase: 8:Excavation to -13.26m, Increment 8 4
Results file: drained~Analysis 1.mys
Entity: Plastic strain - Plane Strain
Component: EPE

75E3
B8.75E-3
0.01

Maximum 0306056 at node 380
Minimum 0.0 at node 1

Prop Force

e Turn off the display of the Deformed Mesh and Contours layers in the
Treeview.

e Turn on the display of the Mesh layer in the [ Treeview.

20



| utilities

Viewing the Results

| Graph Wizard...

o In the L=l Treeview right-click on the group name Wall and select Show Results >
Results Plots> Show Results Only On This Group

¢ Right-click on the group Wall in the L2l Treeview and select Set as Only Visible.

o Select the node at the top-left of the wall thatis
supported by the prop in the X direction.

e With the Time history option selected click
Next. B

Firstly define the data to be used for the X axis. H
e Selected the Named option and click Next. Select this node

e Select Loadcase ID from the drop down list
and click Next.

Secondly define the data for the Y axis. =
e With the Nodal option selected and click Next.

e Select Reaction from the Entity drop down list and RSLT from the Component
drop down list.

e The selected node number will appear in the Specify node drop down list. Click
Next.

o Enter suitable text for the graph titles and click Finish to display the graph of heave
behind the wall.

Drained analysis of a propped retaining wall

Prop force
1200 === T T T YT T T T T T T

GIEE ., e
a1 ) SRS S S S S O SR S A S S S

1) S USSR SN N 0 5 S SN PR MRS NN SO SO

Force

731 ) S S AT S I S O S NS S S S SO SN SO S

200 f----- T EeT oo STTERY FETT PRRPERRTRS RRES R REEEES S SEREEE SEEEEEY FEPTEE LR FELTER LS

o wm o
Loadcase Id
—®— Resultant Reaction Mode 751(8) / Loadcase ID(E)
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| Utilities
| Graph Through 2D...

Drained Nonlinear Analysis of a Retaining Wall

Note. The resultant reaction has been graphed in the above figure. Since the wall is
propped only in the horizontal (X) direction at this location (see Supports section) there
is no reaction in the vertical direction and therefore the resultant reaction is identical to
the horizontal reaction.

. El Close the graph window.
. Maximise the graphics window.

Bending moment in the wall at 10m Depth

Because the model contains elements with two different material properties the active
set on which results are to be plotted must be chosen.

e Turn off the Deformed mesh layers in the Treeview, and restore the Geometry
layer by right-hand clicking on a blank area of the model view and selecting
Geometry.

e Ensure the Snap to grid option is selected and enter a value of 1 for Grid size.
e Clickon OK.

o With reference to the ruler on the edge of the view wiondow, draw a line with the
mouse through the wall at 10m depth as shown.

e Ensure the Active loadcase radio button is selected, and press Next:

e Select Resultant effects from 2D model and ensure that only the Bending stress
option is selected in the list and click Next.

22



Viewing the Results

slice Data
(%' Resultark effects Fram 2D madel
" Results component: " Resultant effects From slice
Entiky IDlspIacement j [IMean normal stress Sz

I -l
e | [T [Mormal stress Sz
Transform  5ef... | Mone [IMean shear stress

[CJActual shear stress

Calculate distance as angle

w |00

Arcceptre 0.0
Z |o.o

Width For corridor averaging IU-U

< Back ek >

o Enter suitable text for the graph titles and click Finish. A graph is drawn and the
bending moment (and other information) is displayed in the Text output pane.

Drained analysis of a propped retaining wall

24000 Bt oo bbbk
14000
4000

-6000

hean Mormal Stress Sz

-16000

Bending mament in wall (-10)

-26000
=

Distance

Bending Stress(S) / Distance(d)

Dataset 17 . no. of walues 2 range -170.092 to —170.092 {mean shear)
Data=zet 18 . no. of wvalues 2 range —-180.236 to —159.948 (actual shear)

2D Forces-moments

Loadcasse "8: Increment 8¢

Fe=ult= File "drained new“Analy=siszs 1 my=" (ID=1)
Awial force per unit width = —-48. 2826

Shear force per unit width = -170.092

HMoment per unit width = 4. 17332E3

Section Depth 1.0

Mean normal stress Sz = —48.28726

Hominal bending stres= = 25 .0399E3

The bending moment reported is 4173 kN/m? per metre run of the wall.

This completes the example.

23



	Drained Nonlinear Analysis of a Retaining Wall
	Description
	Objectives
	Keywords
	Associated Files

	Modelling
	Running LUSAS Modeller
	Creating a new model
	Mesh Definition
	Profile Variation
	Feature Geometry
	Mesh Grading
	Assigning the mesh attributes
	Material Properties
	Assigning material properties
	Supports
	Loading
	Assign the loads to the model.

	Birth and Death
	Analysis Control
	Saving the model

	Running the Analysis
	If the analysis is successful...
	If the analysis fails...
	Rebuilding a Model

	Viewing the Results
	Wall Displacement
	Surface Heave
	Plotting contours of plastic strain in the soil
	Prop Force
	Bending moment in the wall at 10m Depth



